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General Information 
 
This is not a manual. The topics described here do not go into details. Please consult the 
complete manual: http://www.cpcweb.com/TechSupport/CapMaker/CaptionMakerManual.pdf  
 
Software Updates & Tech Support 
For the most up-to-date manual, please check the software downloads page:  
http://www.cpcweb.com/download. Also check http://www.cpcweb.com/TechSupport/CapMaker for 
CPC knowledge based documents for different topics. 
 
Transcribing Video 
If you do not have a script of the video, you can get the script in many ways, such as:  

• If you use a digital video, you can use a foot pedal control like vPedal to transcribe the 
video. It costs less than $90. Details can be found at: 
http://www.cpcweb.com/caption_common/VPedal-AllAbout.pdf. 

•  Train speech recognition software such as ViaVoice for a few hours. Then listen to the 
videotape and repeat the dialogue into the microphone. At the beginning, you are going 
to get lot of errors. But you can teach the software to fix the errors and down the road you 
can expect to get about 90% to 95% accuracy.  

♦ Dubbing the audio onto a tape, and then use a traditional Dictaphone® type machine (tape 
recorder you control with you foot, so you can keep two hands on the keyboard) can speed up the 
transcription process. 

♦ Use a professional transcription service. This is the most expensive way to generate the script. 
 
Even though it is not advisablable to transcribe a video within CaptionMaker, if you must do it, 
there is transcription mode, which can be found inside the File menu. You can switch between 
Transcription mode and Edit mode by clicking on Edit on the bottom status bar. 
 
HASP Key (Dongle) 
If CaptionMaker does not recognize the CPC Protection Key (CPK), please download the software for the 
HASP driver http://www.cpcweb.com/download/haspinstall.exe from 
http://www.cpcweb.com/download/cmplete_downloads_new.htm#Utilities  which will perform un-
installation and re-installation of the HASP driver for the CPC HASP Protection Key (dongle). 
 
Upgrading CPC Software 
(This will only work if your received the software key after 1/1/2002) 
 
You can upgrade your CPC software from any level to a higher level (i.e., CPC-700 to CPC-700NLE) 
over the internet. You do not need to send the USB or the parallel hardware key via mail to be replaced. 
We will upgrade the key via the internet.  
 
2. Run the CPC software. Go to the Help menu and click on Upgrade License 
(If you do not find the menu item Upgrade License, follow the step below to install the most recent 
version of your level of software. Now you will see the Upgrade License Screen under the Help menu.) 
 
3. Now click on Display License ID. 
 
4. Copy and paste the string of characters and send to info@cpcweb.com 
 

http://www.cpcweb.com/TechSupport/CapMaker/CaptionMakerManual.pdf
http://www.cpcweb.com/download
http://www.cpcweb.com/TechSupport/CapMaker
http://www.cpcweb.com/caption_common/VPedal-AllAbout.pdf
http://www.cpcweb.com/caption_common/VPedal-AllAbout.pdf
http://www.cpcweb.com/caption_common/cap_via_voice.htm
http://www.cpcweb.com/download/haspinstall.exe
http://www.cpcweb.com/download/cmplete_downloads_new.htm#Utilities
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CPC will email you a *.dat file.  
 
Now you need to follow step 3 inside the Upgrade License screen to Upgrade your software to a higher 
level. 
 
Install most recent version of software 
You can download the most recent version of the software from the software downloads page: 
http://www.cpcweb.com/download/cmplete_downloads_new.htm 
 
Now follow the steps: 
1. Uninstall the old version of the software. (Keep note of your caption and Time Code devices) 
 
2. Disconnect the USB or Parallel hardware key from the computer. 
 
3. Install the new upgraded version of the software. You will need a password, which we will be provided 
to you. 
 
4. Connect the USB or Parallel hardware key to the computer. 
 
Accented Characters: Multiple Keystroke Method 
If you do not know how to use your keyboard to type characters used in a particular foreign language, 
you can install them into your keyboard so you can type those characters with multiple keystrokes. 
 

1. To install the keyboard to type accented characters, go to Start > Settings >  Control 
Panel  >  Keyboard, and click on the Language/Input Locales tab.  

2. Click on the Properties button. On a Standard United States version of Windows, a pull-
down box will appear containing many keyboard layouts. 

3. Select the keyboard layout United States - International. Then click OK. 
 
This keyboard will allow you to type accented English characters used in most European languages, 
including French, German, Spanish, Danish, Italian, Dutch, Finnish, Portuguese, Norwegian and Swedish. 
 

Character First Key Second Key
 

á ' (under the ") a 
à `(under the ~) a 

 
 
Available Captioning Characters  
The languages supported by the closed caption decoder technology includes following languages: 
 

♦ Dutch 
♦ English 
♦ French 
♦ German 
♦ Portuguese  
♦ Spanish 

 
Captioning Process (Outline) 
Please read the document http://www.cpcweb.com/Captioning/CaptionSoftwareOverview.pdf  to 
get a overview of how captions are created using CaptionMaker. 
 

http://www.cpcweb.com/download/cmplete_downloads_new.htm
http://www.cpcweb.com/Captioning/CaptionSoftwareOverview.pdf


 4

 



 5

Time Code Related 
 
Drop Frame vs. Non-Drop Frame Time Code 
There is no time code track on the A/V file. CPC keeps track of the video frames starting with 
00:00:00:00 time code for the first frame of the video, and keeps a frame counter that counts 29.97 frames 
per second (on average). The exact counting mechanism is bit more complex. This is exactly the same 
way drop frame time code is used for videotape format. That’s why the time code from the Video 
Playback acts in the same way as the drop frame time code does for a videotape format. If you have a 
video file on the hard drive that is exactly one hour long according to the clock on your wall, the very 
first time code of the first frame of the video is 00:00:00:00 and the time code of the very last frame of the 
video is exactly 01:00:00:00. On the other hand, the time code of the very last frame will be 00:59:56:12 
for Non-Drop frame. There is difference of 00:0:03:18 frames. 
 
Drop Frame/Non-Drop Frame & NTSC/PAL 
If the time code formats on your work tape and master tape are different, you may covert them between 
NTSC and PAL and also between drop frame and non-drop frame. See Convert Time Code in "Chapter 8: 
Menus" for details. To convert time codes from one to another (PAL and NTSC or drop to non-drop) 
highlight the time codes you would like to convert and use this option to convert them from one to 
another. 
 
Stretch/Shrink Time Code 
This option might be very useful when you work with a digital video or a tape (work copy) and do all the 
time coding, and then need to match the time coded file with another copy of the video (master copy), 
which may have a slightly different code at the end of the video. One reason this could happen is due to a 
drop frame/no drop frame issue. To match the time code of the caption file with the video, make sure the 
first time code of the caption file matches with the master copy. Then choose this option and enter the last 
time code from the master copy. This option will stretch or shrink all the time codes in the caption file to 
match the master copy.  
 
In most situations, you should have the box for “Master time code is drop frame” checked. 
 
Fine tuning of time codes: Ctrl + & - 
If you need to change a time code by small amount, click the cursor on the time code cell and press Ctrl+ 
or Ctrl-. This operation with change the time code value by 1 frame.  
 
Calculate send time for Pop-On (Captioning commercials) 
This feature is very important when you caption a short commercial. In a commercial, if you add a Pop-
On caption at the very beginning of the video, you may lose the caption. Since Pop-On captions need 
build-up time in order to be displayed on a particular frame of the video, you have to make sure that the 
onset of the caption is within the first frame of the video. Right click on the first time code under the Start 
Time column and make sure the send time of the first caption is well inside the beginning of the video. 
 
Fine-Tuning AutoSync with PC System Timer 
If you are using the PC System Timer to Auto Sync the caption file, you might find captions appear little 
too early or too late as time progresses. If the captions appear too early, press [Alt] + [-] to slow them by 
one-third of a second. Press it again to slow the display of captions by another third, and so on. If captions 
appear too late, speed them up with the [Alt] + [+] key; the same rates apply. The only sure way to 
synchronize the time code and program is to use time codes on the tape along with the CPC-700 series. 
 
Adjusting Time Cue to Compensate for Human Reaction Time    
When you press the [+] key to record the time stamp, there is always a possibility of an error of few 
frames. The source of the error is the reaction time from the time you hear the first word spoken until the 
time you press the [+] key. Assuming it is always a consistent error, you can change the time stamp of all 
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the rows by a few frames using the Ripple time code option. Left-click on the Start column header to 
highlight all the time cues, and then right-click on the time code cell of the very first row and choose 
Ripple time code. Now you can enter the new time cue (a few frames more or less than the time cue of the 
first row) to replace the time cue of the first row and ripple the time cues for the whole file. 
 
 



Caption Related (General) 
 
Reformatting Captions   
After you import a file and work on it for the Pop-on or Roll-up display modes, if you change your mind, 
you may use 3 reformat functions from the Format menu to change the file for Pop-On or Roll-Up modes. 
See the section on Reformat Rows in Chapter 8: Menus for details. 
 
Reformat Caption(s) to Roll-up 
If you have a block of captions or the entire file created for Pop-on or Paint-on captions with more than 
one line of text in each cell, you can convert the block or the entire file to Roll-up captions containing 
only one line of text in each cell. This option will maintain the existing time codes assigned to the file, 
distributing the allocated time for a pop-on/paint-on caption to multiple lines broken up for Roll-up 
captions. Just highlight the block of caption or the entire file and invoke the option. 
 
Reformat Caption(s) to Pop-on 
If you have a block of captions or the entire file created for Roll-up captions, you can convert the block or 
the entire file to Pop-on or Paint-on captions. This option will maintain the existing time codes assigned 
to the file distributing the allocated time to multiple lines combined for Pop-on or Paint-on captions. Just 
highlight the block of caption or the entire file and invoke the option. 
 
Commercials with existing Captions 
If your device is a CC encoder, when you invoke this option, it will free up the encoder. If a video with 
pre-recorded captions passes through the encoder, when the device is closed, the captions will pass 
through. This might be very helpful when you are captioning a live broadcast and the TV station airs 
some commercials with existing captions. If the device is not closed, the existing captions from the video 
will be stripped off. 
 
Flashing Captions 
If you are see captions are flashing and you really do not want to have them flashing, make sure 
the caption text is not bold. Bolding makes captions to flash. 
 
Two Captions Appearing Simultaneously 
You may wish to have two or more captions appear on the screen at once, but in different positions (the 
top and bottom of the screen, for example). The need for this may arise in a program where two people 
say different things at the same time. If you have two captions with the same Start Times, both will appear 
on the screen simultaneously. The easiest way to do this is to skip over one of the rows while assigning 
time code, and later cut and paste the Start Time from the row where you did assign time code to the row 
that you did not assign a time code to. Of course, you should assign different positions to these captions 
so they will both be visible. You may also use the function Same Start Time to assign same time code to 
multiple rows. Highlight multiple rows with time code, right-click on any highlighted row and then click 
on Same Start Time. 
 
 
Encoder Communication Error 
If you do not have a device attached to the computer, choose "Virtual Encoder" as your device. The 
CaptionMaker will not send any data to the encoder via the serial por,t and you would not get any 
communication errors. 
 
AutoSync/AutoPreviewSync  

After you have associated a time stamp with each row, AutoSync  will automatically output the text 
on each and every row according to the time stamp to the caption/subtitle device.  
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After you have associated a time stamp with each row, AutoPreviewSync  will automatically output 
the text in each and every row according to the time stamp only on the computer screen.  You should use 
this option when you do not have a caption/subtitle device attached to the computer. 
 
Captioning Two Languages on the Same Video 
CaptionMaker can use used to caption two languages on the same video in a limited way.  
 
With ITV-Injector/DV-2000/DV-3000 
The CPC distribution CD contains a utility software called CaptionMerge. First create two CaptionMaker 
.cap files for two languages. Then export two files to Ultech DV2000/ DV30000/ITVInjector (*.ult) file 
format. 
 
Now run CaptionMerge software and do the following: 
  

♦ Choose the first file for CC1 and 
♦ Choose the second file for CC2 to CC3 
♦ Choose CC2 or CC3 for the second language  
♦ Choose the final Destination (merge) ULT file 
♦ Finally, click on the Merge File button 
 

Use this final .utl with the DV2000/ItvInjector.  
Make sure you have DV2000/ItvInjector software version 3.5 or higher. 
 

Note:  Channel 1 and Channel 2 occupy the same space inside the Field 1. The same is 
true for Channel 3 and Channel 4. When you caption two channels in the same field, 
there is always fight with the space between CC1 and CC2. CC1 has the first priority. 
Whatever space is left, is used by CC2. It is good idea to paraphrase the text and make it 
short in both languages when you do CC1 and CC2 caption simultaneously. 

 
With Other Encoders 
Using one computer  
You can caption in CC1 or CC2 (Field 1) in one pass and then run the captioned video through the 
encoder and caption CC3 or CC4 (Field 2) in the second pass. Make sure the option Allow existing filed 1 
data pass through untouched under the Caption > Caption Properties > Control menu is checked. 
 
Using two computers 
You can caption a video in CC1 or CC2 (Field 1) and CC3 or CC4 (Field 2) at the same time.  
 
The encoder must be connected to two computers via  

1. a serial cable or a  modem, 
2. 2 serial cables, or 
3. 2 modems 

Invoke the Caption → Device → Properties option. You will see the following screen. 
 
You have to make sure that you set the following items properly.  

1. Channel (C1, C2, C3 or C4) 
2. Allow existing field 1 (or 2) data to pass through untouched. 
3. Send caption data if available box is checked. 
4. Caption 2 or more channels – send init code for each line box is checked. 
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In the previous dialog box, CPC is set to caption in Channel 3 (field 2) under one of the following two 
situations:  

1. caption data is sent to the encoder  in channel 1 simultaneously via a modem or a serial cable or,  
2. the video is already captioned in channel 1  

 
A few important points to note: 
You can have either of the following situations: 

1. Both computers running CaptionMaker software or 
2. One computer running CaptionMaker and the other computer running another captioning 

software. 
 
You may mix and match any of the two methods of captioning: 

1. Live or Realtime or,  
2. Live Display or,  
3. Post Caption. 

 
In Live Realtime method, you can use either a steno machine or Speech Recognition software to send the 
caption live. 
 
In Live Display method, you have to have the text prepared already. Then you can send the captions by 
pressing the (+) key in real time by listening to the dialog. 
 
If you have access to the time code of the video, you may use the Post Caption method. You must have a 
already prepared time stamped file. Then you can invoke the AutoSync function and captions will go 
automatically synchronized with the video. 
 

 



Error Checking  
 
AutoSync Error Checking 
If this option Caption > AutoSync Error Checking is checked, CaptionMaker will go through the whole 
file and make sure there is no missing time codes, or the time codes not in ascending order before starting 
AutoSync. It is a good idea to have this option checked. That way, for a long video you do not have to 
wait for long time until the error is caught – at which point AutoSync will stop. 
 
Final Checking 
It is a very important to check all timing and formatting errors before you do the final encoding. This 
option is available under Caption > Final Checking menu, and also can be accessed by clicking on the 

 icon at the top left corner of the screen. You can set your favorite parameters on the following 
window, and check for errors after preparing a caption file and before using that file for encoding or any 
other purposes.  
 
When you invoke this option you will see a dialog box below where you may choose options related to 
time code tolerance, reading speed of captions, maximum characters per line, unacceptable characters for 
captioning, etc. 
 
Timing Error Settings 
When you caption a video, it is very important that you conform to maximum WPM for captions, 
depending on your audience. Similarly, it is customary not to have a Pop-on caption covering a shot 
change. And finally, if you do not give enough time for a Pop-on caption to build-up, the caption will not 
appear at the desired time you assigned. For Pop-on captions, for every 50 characters of text, it takes 
about a second for these 50 captions to build up in a buffer prior to being displayed on the screen. If the 
difference of time codes of the previous caption and this caption is less than 1 second for a caption of 50 
characters, the caption will appear little later than the assigned time code. To check all these errors on the 
fly, you can invoke the option under Caption> Timing Error Settings menu. You can check any one of 
the following items and assign different colors for each error in the following dialog box. 
 

 
 
Find Shot Changes 
You can find the shot changes in any video (wmv, avi, mov, mpeg, m2v etc.). It is a good idea 
not to have a shot change inside the duration of any caption in the Pop-on mode. Try to place the 
caption after a shot change or finish displaying a caption before a shot change occurs. This is for 
esthetic purposes. 
 
After you open a caption file with the appropriate video file, to find the shot changes, click on 
Tool > Find Shot Changes. 
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It will take a while depending on the length of the video to find the locations of all the shot 
changes. When you save the caption file, the shot change information will be saved in the .cap 
file. So when you open the .cap file again later, you do not need to find shot changes again. 
  
After finding the shot changes, when you play the video, the next shot change indicator appears right 
below the Time code display in HH:MM:SS:FF format. The next shot change display color becomes RED 
when it is less than 10 seconds from the next shot change. 
 

You can also click the two buttons ( ) next to the time code display area to move to the previous 
and next shot change locations. 
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Digital Video Related 
 
Real and QuickTime video   
CaptionMaker relies on the Windows engine to play all video files. At the time of the writing of this 
manual, WMP does not play rm files. As a result, CaptionMaker can’t play RM, or Real Media files. To 
open a rm file, you may install a third party software which allows WMP play rm videos. As a result you 
can open a RM file in CPC. You may download the software from www.free-
codecs.com/download/Real_Alternative.htm. CaptionMaker made a special effort to play QuickTime mov 
even though WMP can’t play MOV files. You have to check the box for QuickTime files when you open 
the video. 
 
Video Codecs 
When you play video in the CaptionMaker, you need to have some idea about different video codes. 
Usually software like Windows Media player, QuickTime Player, and DVD Player installs appropriate 
Codecs to your computer. You need to get involved with Codecs only when you can’t play a particular 
video. Most probably the video was created with non-standard Codecs. Below are a few relevant software 
and codec sources: 
 
Play Real Video and QuickTime on Windows Media Player 
You may download the free software to play RM and QT files in WMP and CPC from: 
http://www.free-codecs.com/download/Real_Alternative.htm   
 
Video Codecs for Mpeg/DV etc.  
http://www.mainconcept.com/products.shtml is a good source of Mepg2 and DV Codec.  You may 
download the software install the Codecs. 
 
 
 

http://www.free-codecs.com/download/Real_Alternative.htm
http://www.free-codecs.com/download/Real_Alternative.htm
http://www.free-codecs.com/download/Real_Alternative.htm
http://www.mainconcept.com/products.shtml
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Captioning Digital Videos 
 
Print to Tape a Captioned DV video 
When you caption a DV25 or DV50 digital video, you can use "Print to Video" function from the NLE 
menu of CPC-700NLE software to copy the DV video to a tape. 
 
A list of compatible DV deck and media converters are at: http://www.cpcweb.com/dv/dv-hardware.htm  
 
Print to Tape a Captioned NLE video 
http://www.cpcweb.com/nle/nle-printtotape.htm  
 
Known NLE presets  
You need these preset values for your NLE system when you export 720x486 black video. 
 

NLE System  Primary Row Starting 
Column  

AJA Io, AJA Io LA  1  24  
AJA KONA LS  1  24  
Avid Express Pro  1  26  
Avid ABVB  0  35  
Avid DS Equinox  1  26  
Avid Meridien  1  26  
Avid Adrenaline  1  35  
Blackmagic DeckLink Extreme  0  26  
Leitch DPS Velocity  1  26  
Matrox DigiSuite  1  30  
Media 100  1  26  
NewTek Video Toaster 3 & 4  1  19  
Sony XPRI  1  26  
TARGA 1000-3000  1  26  

 
For more recent updated list, check the document http://www.cpcweb.com/nle/nle-hardware.htm  
 
Primary Row and Starting Column 
If your system is not listed, you need to know the primary Row and Starting Column numbers for your 
NLE system. If you know those values from the test described earlier in this chapter in the actual manual, 
please enter those numbers here. Note: Secondary Row information is not important unless you are using 
Alpha Channel. 
 
Alpha Channel 
If you can’t use Crop-in effect to add the black video to your video, you can use black as Alpha channel.  
 
You can select either AVI file output or QuickTime file output if QuickTime is installed. The selection of 
"Millions of Colors+" in the QuickTime codec dialog box will generate a 32-bit output file containing an 
alpha channel. Other output selections generate 24 bit movies.  
 
Note: If you generate an alpha channel, you should set the Secondary Row equal to the Primary Row in 
the Preferences dialog, to prevent a second occurrence of closed caption data from being inserted into 
your video program. 
 
 

http://www.cpcweb.com/dv/dv-hardware.htm
http://www.cpcweb.com/nle/nle-printtotape.htm
http://www.cpcweb.com/nle/nle-hardware.htm
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Tools 
 
Customize Key Strokes 
Most of the menu items and commands can also be accessed via keyboard. We encourage you to 
customize the keyboard. CPC has some default keyboard settings, but those may not be your choice. You 
can use the software much more effectively with a proper combination of mouse use and keyboard 
shortcuts.  
 

Keypad Keys  To assign any key on the keypad, you must have NumLock On. 

 

Tip    If you are running CaptionMaker on more than one computer, and you want to copy 
the Customize Keystrokes from one computer to another, you need to copy the file 
CapKeyMap.dat from the folder C:\ProgramFiles\CPC\CaptionMaker from your 
computer to the same folder in the other computer.  

Dictionaries 
If you uninstall CaptionMaker software you will loose any new dictionary entries. Before uninstalling the 
software, you may copy the files ssceam.tlx and ssceam2.clx (for English dictionary) from 
C:\ProgramFiles\CPC\CaptionMaker to a different folder. If you reinstall the CaptionMaker software 
again, you may copy these two files back to the same folder. For other languages there are corresponding 
files ending with the two character abbreviation of the language (e.g. sp: Spanish, etc.) 
 
Automatic Match Text with Audio  
CaptionMaker software can now automatically break and accurately time closed captions at the click of 
button. There is a service fee for this function. This automates the labor-intensive job of having a 
captioner listen to the audio, manually break the text into captions, and then synchronize the captions with 
the dialogue. 
 
With CaptionSync automated captioning software from Automatic Sync Technologies, the captioner 
connects to the internet and uploads the script and the corresponding audio file to a file server. Within 
minutes, a time stamped script file can be downloaded on the computer. 
 
This service starts at $65 per one hour file. You can buy this service by contacting Automatic Sync 
Technologies directly at 510-582-3437 or kevin@automaticsync.com. For more information please check 
www.automaticsync.com 
 
To automatically synchronize caption dialog with the audio portion of a video choose Auto Match Text 
with Audio from the MacCaption Special Pull Down menu. You will be presented with a window that 
controls the uploading of your caption dialog and an audio file of that dialog to a remote host for 
processing. This window also controls the downloading the synchronized text file.  
 
To upload files for automatic synchronization you must prepare a dialog file and an audio MP3 file. The 
text file should be a plain text file that ends with the “.txt” suffix. The text file should consist of the entire 
spoken dialog in the video that is being synchronized.  
 
The audio file needs to be an MP3 audio file that is 16 bit 44.1 KHz and 32 Kbps. 
 

mailto:sales@cpcweb.com
http://www.automaticsync.com/
http://www.automaticsync.com/
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Live Captioning 
 
 
The CaptionMaker is designed for live realtime captioning using a steno machine. 
 
Additionally, it can also be used for: 
 

1. Budget realtime captioning using optional speed typing software.  
2. Budget realtime captioning using optional speech recognition software. 

 
Speech Recognition Software 
Speech Recognition software as it is available in the market at this moment, can’t just recognize 
anyone voice without any training. If you spend an hour or so to do the training with your voice, 
you will get about 85% accuracy. If you keep on working with the software and teach the 
software your voice by correcting the wrong words, the software do have the capability to learn 
and you can easily get to 95% accuracy after working on it for several hours. 
 
With the speech recognition software, you can listen to a live program, and repeat the words that 
are being said into the microphone. CPC CaptionMaker software will automatically send the 
words to an encoder and the live program will be captioned. We have and many of our customers 
have had a lot of success using this software 
 
Accuracy & delay 
Naturally Speaking software analyzes a complete sentence or a phrase until you pause talking 
and gives better accuracy compared to ViaVoice. Since Naturally Speaking analyzes the text 
before showing it on the screen, if you use it for live captioning, the captions might be delayed 
by a few seconds. For transcription purposes, the delay does not matter. So Naturally speaking is 
better than ViaVoice from the accuracy point of view. 
 
Lanuguage supported 
Naturally Speaking is available in multiple languages such as, English, Spanish, French, 
German. ViaVoice is available only in English 
 
Dragon Naturally Speaking  
Dragon Naturally Speaking To use Dragon Naturally Speaking versions 7 and up with Captionmaker, it is 
necessary to execute a utility software called DnsIniFix. This utility will find the Naturally Speaking ini 
files on your computer and add an entry to them for CaptionMaker. The utility software DnsIniFix.exe is 
available from http://www.cpcweb.com/download/cmplete_downloads_new.htm#Utilities. 
 

http://www.cpcweb.com/download/cmplete_downloads_new.htm#Utilities
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